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Copyright Declaration

Shenzhen Ruida Technology Co., Ltd. (hereinafter referred to as “Ruida Technology™)

All rights reserved.

1.

Ruida Technology holds the patent rights, copyrights and other intellectual property rights for this product and
its related software. Without authorization, none company or organization or individual is allowed to copy,
manufacture, process and use this product and its relative parts directly or indirectly, otherwise shall be
investigated for legal responsibility according to the law.
Ruida Technology is entitled to increase or reduce and modify the products and functions of this product stated
herein as well as amend any documents attached to this product, without prior notification.
The users should peruse this manual prior to using the product stated herein, Ruida Technology shall not be
responsible for the direct, indirect, special, incidental or corresponding losses or damages arising out of
improper use hereof or of this product as below:

® Users using this manual or product improperly

® Users not follow the related safety operation rules

® The loss caused by the forces of nature
The machine in operation is dangerous, so the users are obliged to design and institute the effective mechanism
for error handling and safety protection. Ruida Technology shall not undertake any duties or responsibilities for

the incidental or corresponding losses arising therefrom.
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Safety
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Warning laser

Live Focus System (LFS) is applied in laser processing machine. Laser protection is CLASS3 and CLASS4.

Please reference to GB7247.1-2001 and take some safety protection measures.

The following should be executed:

Operation persons should wear protection glasses.

Connected to the ground. A valid connection to ground should be done and the resistance should be less than
lohm. CNC machine tools, LFS, sensor shell and support plate should be stable grounding.

Please do not try to disassemble the parts of LFS. Otherwise, the LFS will be fault.

Laser beam nozzle and the LFS sensor are integrated design. When the LFS is working, please do not touch
the sensor. Otherwise will cause damage to your body.

When cutting glossy surface metal, please notice the reflect laser beams from the metal surface. Some
protection measure should be taken to avoid the body to be damaged. Preventive measures should be taken
and operate carefully, to prevent burn out parts by laser beam off center axis.

Keep the sensor and nozzle clean. Avoid the cooling water, condensed water or other foreign matter flowing
into sensor; otherwise the sensor will be fault. The laser power and other controllers should meet the EMC
standard and should be connect to the ground reliably.

Sensors and electrical cabinet parts must be grounding as requirements. Processed metal artifacts should be
reliable grounding.

6/81
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Chapter 1 Overview

1.1 Visual Cutting Control System Introduction

Visual cutting control system (RDVision) is cutting system based on intelligent target recognition. This system is
mainly composed of PCI motion control card and CCD industrial camera. Combined with image processing
algorithm for target image feature extraction and target recognition and finish cutting work by artificial cut outline.
The system operating software control card and the upper machine by Ethernet or USB interface for
communication.

This system user friendly interface, stable performance, simple operation, suitable for large-format array type

graphics cutting, such as trademark cutting field.

1.2 The composition of the visual cutting control system

Control system consists of two parts, hardware and software.

Hardware equipment as shown in Figure 1.1

7181
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Project Quantity
Control card 1 pcs
Control panel 1 pcs
LED loop lighting group Iset
Driver board 1 pcs
Lens I pcs
Camera (with cable) 1 set
Brightness regulator (with cable) Iset
Transfer fold-resistance cable Ipcs
Mechanical mounting bracket 1 set
KF3.81 socket 6P 9 pcs
KF3.81socket 5P 1 pcs
KF3.81socket 4P 3 pcs
KF3.81socket 2P 1 pcs
DP15 data cable (1.5M) 1 pcs
USB cable (1M) 1 pcs
Reticle (5M) 1 pcs
internet access cable (1M) 1 pcs

Figure 1.1

Software is RDVisionSetUp.

1.3 Software installation

Software installation and system hardware configuration requirements:

(1) Running on Windows XP and above version operating system, it is recommended to use the Windows XP.
(2) CPU 586 above, it is recommended that the PIllor above PIV.

(3) It is recommended to use more than 1 G of memory.

1.3.1 Start installation

Double-click the install directory RDVisionSetUp.exe icon, dialog box (Figure 1.2) will popup as follows:

81/81

© 2016 Ruida Technology. All Rights Reserved.


javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

@)

RDVision Laser Cutting Control Software Operation Manual RuibaAcs

<A RD¥isionl. 0. 12 Install

Welcome to the RDVision Setup Wizard

This wizard will guide vou through the installation of RDVision.

It is recommended that you close all other applications before starting Setup. This
will make it possible to update relevant system files without having to reboot your
computer,

Click Mext to continue.

| nstal | [ cancel |

Figure 1.2
Click on the "Install" button, to extract the replication is complete, install the interface (Figure 1.3).

Lengusce:| EXETETNINN

| Install camera ||Uninstall camera

| Install USB Uninstall USE

E]Locate install path

Install software

Exit

Figure 1.3
1.3.2 Driver install and uninstall

Camera driver install and uninstall:
Click [ Install camera ] button on the main interface (Figure 1.3), installation interface will be appeared in Figure 1.4
9/81
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Device Driver Installation ¥Wizard

Welcome to the Device Driver
Installation Wizard!

computers devices need in order to work.

To continue, click Next.

This wizard helps you install the software drivers that some

E=ZT |

K

J

Figure 1.4

Click "next":

Device Driver Installation Wizard
Completing the Device Driver
Installation Wizard
The drivers were successfully installed on this computer.
The changes will not take effect until you restart your computer.

Driver Name Status
v Microsoft [USBSCAN] Im... Device Updated
T
Figure 1.5
Click "finish" button to end the camera driver installation.
10/ 81
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If the user need to uninstall the [ camera driver], clickl uninstall camera] button on the main interface (Figure 1.3),

will appear the interface in Figure 1.6:

Uninstall Driver Package

\g;) A11 devices using this driver will be remowved. Do wou wish to continue?

B |

Figure 1.6

Click "yes" to uninstall the camera driver.

Controller driver install and uninstall:

Users click [Install USB Jon the main interface (Figure 1.3), prompt to connect USB, to make sure connected USB,
click “OK”.

RD¥isionSetlUp

'E Before install, connect USE first!
..

Figure 1.7

And then displaying the interface as Figure 1.8 showed:

RD¥isionSetlp

Figure 1.8

If the user need to uninstall the motherboard driver, click [ Uninstall USB] on the main interface (Figure 1.3) will
appears Figurel.9:

11781
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RD¥isionSetUp

! Uninstall USE drivers finish!
LY

Figure 1.9
Click "OK" to uninstall the controller driver.
The Software installation:

When users installed the camera driver and motherboard driver, click "Install software" button on the install main

interface (figure 1.3) .and it will pop-up a prompt interface “Install Finish!”.

RD¥isionSetUp @

L
1 ) Install Finish!

Figure 1.10

Click “OK”, visual cutting software installation is completed.
If the user set the installation path manually, check the option "manually locate the installation path" on the main

interface (figure 1.3). Position setting interface will occur in the following installation process (figure 1.11).

12781
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Figure 1.11
After choose the required path, click [OK], the program will be installed under the user setting path.

1.3.3 Exit

The system software installation is completed, click "Exit" button on the install main interface (figure 1.3) to end

installation process.

1.4 Software Features

. Compatible with AI, BMP, PLT, DXF, DST, and other graphics data format.
. Can edit and typeset simple graphics, text, and import the data.

. Layout and define the output sequence.

. Can set the machining process and precision personally

. It can realize processing path optimization function.

. Suspension in the manufacturing process of processing.

. According to the different requirements of processing can be set as a starting point, the work path.

00 9 N L AW =

. Compatible with many kinds of communication mode, the user can use USB-port communication or network

communication according to the actual situation.

13781
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Chapter 2 Software Basic Operation

2.1 The main operation interface

Start the software, can see the interface as shown in the figure below. Familiar with the operating interface, the

software will be used for the basis of laser processing.

System Toolbar Cutting properties bar

{ Menu bar

% ..-[Blank]
File(F) Edit(E) Draw(D) | Config(S) Handlel

View(V) Help(H)

o =
Process NO: |0

Drawing
toolbar

Searchnum  Offset Dislocation

SIE 100.000  0.000

y: 1 100000  0.000

~ | osten |[_see ] [F]]
s - Control
= >
T ] Panel
i1 o o]
b 4
U+ |[Feed| U- |
Alh AI_J []Enable valid zone
i [lstepmode
= Speed(mm/s): 200.0 | Return posnuon:
=
5 .
o Main
Interface

Please create model

--- *Welcome to use the Laser systgm of cutting,Propose the display area 1024*768 of higher *--- Thtal T:000:05:04:653:Single T:000:00:17:301:Work num:57 X:22.800mm,Y:-8.800mm

Machine View Model View Camera View

Figure 2.1

[ Main interface view] : The current perspective is video, display data for the camera view. If need to switch into

the Machine view, simply click on the machine view, will switch to the machine perspective:
14/ 81
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% ..-[Blank]
File(F) Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)

oo aaqeaqaq mHEGFYOM%Y!

mm & 0 mm| 0 %ﬂﬂ = 3 -
mm § 0 mm| 0 % G - Process NO: |0

/ Searchnum  Offset Dislocation

. B 100.000  0.000
v 1 100.000  0.000

» B (o

H v+ Work para

{FI x- | %99 | x+ | | [Mod st

El

X U+ |Feed| U-

Alh - [T Enable valid zone

g Flstes e

~ Speed(mm/s): 200.0 | Retum positon:Orign v

B

O

e

gea

B8

Please create model
- *Welcome to use the Laser system of cutting,Propose the display area 1024°768 or higher *--- [Total T:000:05:04:653:Single T:000:00:17:301:Work num:57 X:7.000mm,Y:-7.500mm

Figure 2.2
Ditto, can also switch to the Model View.

Process | Model

As shown in figure: as the switch on the control panel module management. Each model

manages the important operating parameters and related functions.
[ Menu bar] : the menu bar file, edit, drawing, setup, processing, view and help seven functions menu items.

[ Cutting properties bar] : mainly is the basic attribute of graphics, contains graphic location, size, model basic

properties such as zoom, and processing sequence number.
[ System toolbar] : toolbar buttons for the most commonly used features, most of these options from the menu bar.

[ Drawing toolbar] : when the system default is located in the work area on the left. On the drawing toolbar placed

often use the editing tools, can undertake various edit operation to need to edit the object.

[ Control panel] : Control panel and main implementation of some commonly used operation and settings.

15781
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2.2 Language settings and manufactures information

In addition to the application installation process can set the language type of software, in use process also can
switch different languages.

Click "menu" - > "Help" - > "i& & /Language", select the required language type, which can

switch language.

g About RDVision | [ x X[

Il 55 /Lancuece > MRS

’ Edpx
Other

To attain manufacturer information, so that manufacturers provide a better service for you. Click [menu] - > [help]

- > [About RDVision], can display manufacturer's information.

Corp. Name: 1
L

Tel

|
Fax:‘

Addr: l

|
|
|
|
|

Web: l

RDVision¥1.0.13 QK

In "about prompt interface" below is the current software version number. In different software version, there are
differences in function or interface. Through the software version number, it can be convenient to contact and

communication with manufacturer for users.

2.3 Page Setting

Click "menu" - > "Settings" - > "page setting", appearing the interface as the following:

16/81
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Page setting @

Page size
Page width: ZEEI | mm
Page height: S00 | mm
Keyboard
Adust distance: |1 mm

Adjust ratio: |10

Adust angle: |

[ Ok ] [ Cancel ]

[Page width]: view page width, size of the X wide general Settings for the machine.

[Page height]: high view page, the Y wide general Settings for the machine size.

Usually, if the PC is connected to controller, the software will automatically gets the current machine working level,
as the page size. Under the condition of PC is not connected to the motherboard, or the user needs to define your
own page size (e.g., according to the material to set the page size), can use the page setup to reconfigure the page

size.

[keyboard] : the software can be through the up and down or so key keyboard to adjust the positions of the graphics
in the view.
According to a direction, moving distance = [ Adjust distance ] ;
Press the SHIFT key and press a key direction, moving distance = [ Adjust ratio] * [ Adjust distance] ;
Press the Ctrl key and press the direction key, graphics rotation Angle = [ Adjust Angle] ;
Press Ctrl + Shift and at the same time press the direction key, the graphics rotation Angle = [ Adjust Angle] *
[ Adjust ratio ]

2.4 Import and export files

Since this software is used. RLD format file, which needs other file format when making or editing done through
import, derived by save as other file format data. Import the file formats supported: DXF, ai, PLT, DST, DSB... And
so on; the exported file format support: PLT.

171781
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2.4.1 Import File

Click on the "menu" - > “file” - > “imported”, or click on the import icon il , will display interface as below

Figure 2.4 shown.

Choose the corresponding file, click "Open" button.

SA
EHEBEDO: [ ~| « % EB-
[ear] 0000033, p14 o] £ P18 ea] BT p1t
r) 98T, p1t ) BEHILpLt ] ELR p1t
] 700D, 1 o] 8398 P14
o] 9576, p1t o] 7. P18
g 080721, 1t o) FEFAEAER. p1t
o] AT. 51t o) L 1
[F]Airplanc oLt SEEEERECC ST
;ﬂklphsbet.plt E—%.plt
o] 40P, p1t o] EEEBETE. p1t
E._'jBeach. plt Eﬂ?ﬂ@.plt
aBox and Curve. plt Epﬁ B plt
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Figure 2.4

If selected “Preview”, will display the image when select the file.

For vector data, the data according to the corresponding hierarchical description file format automatically imported
into the RDCAM corresponding layer.

For some special file like DST/DSB will be import the current layer
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SA
EEBEO: [st ~| « @ ek

WISO. DST

PORSCHEZ. DST
SUNFLOKR. DST
VERONTKA. DST

vV Preview
B W@:  [Ahodiel DST = e 'I
ICHEZER (1) lSupported Filesl L, Wiy

2.4.2 Export File

Click "menu" - > “file"- > “export” or click the icon CH , then show that export operation interface;

Input the file name, then click "save" button.
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2.4.3 File parameters setting
File Parameter @

Import Setting

PLT Precision: EEE ot

-

D¥F Unit: \ MM v |

[]1mport Dxf text info
Auto close curves

Close error{mm): 0.1

Combine lines

Combine error(mm): 10-1

Export Setting:
Export Precision{%): 80

Yelocity Unit: (mmfs | ¥

[ Ok ] [ Cancel ]

[PLT Precision] According to the precision of the original PLT file to choose the appropriate import units

[ DXF Unit] Software default DXF import unit is mm. If there is an import DXF data size does not agree with the
original graphics, may be caused by unit does not match. Optional data unit is mm, c¢m, inch, custom, when choose

the custom, any user set up a unit of data in DXF file corresponding to the RDCAM software in millimeters.

[ Import Dxf text info] When the user need only within the Dxf graphics information, without the need for a file in

the text message, are not checked

[ Curve smooth] Vector file import, automatic smooth not smooth the curve of the original graphics. For original
graphics itself relatively smooth or need to repeatedly adjust the best smoothing effect, are not checked, reduce

import processing time. Processing it after the file imported.
[ Auto close curves 1 According to the close tolerance automatically checks and closed curve
[ Combine lines] According to the merger of tolerance, automatic connection curve

[ Velocity Unit] Speed unit is mm/SEC, m/points two kinds, we can choose according to the habits, the selected

interface about speed parameter units will change accordingly.
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2.5 Basic graphics creation

[ Node edit])

Click on the "menu" - > "Draw" - > "node editor", or click the edit toolbar ‘E , drag the mouse on the screen,

click the mouse at any position, can draw the point.

[Line]

a

Click menu [Draw] -> [Line], or click Edit toolbar ,drag the mouse on the screen you can draw an arbitrary

line. Press the “Ctrl” key while dragging the mouse to draw horizontal or vertical line.

[ Polyline]

Click menu [Draw] -> [Polyline], or click Edit toolbar - - Drag the mouse on the screen And you can draw

an arbitrary polyline.

[ Bezier] Click[Draw]->[ Bezier]or click the Edit toolbar}" .The process of drawing refers to [Polyline] process.

Difference is that when you insert the middle point and hold down the left mouse button and drag to adjust the

curve control points.

[Rectangle]

Click menu [Draw] -> [Rectangle], or click Edit toolbar I:I . Drag the mouse on the screen you can draw an

arbitrary size rectangle. Press the “Ctrl” key while dragging the mouse to draw square.

[ Ellipse]

Click menul Draw }->[ Ellipse 1, or click Edit toolbar D. Drag the mouse on the screen you can draw an arbitrary

size ellipse.

Press the “Ctrl” key while dragging the mouse to draw round.

[ Edit text]

Click on the "menu" - > "Draw" - > “text”, click edit toolbar {FI and then click the drawing area in any position,
the pop-up text input dialog box.
Choose fonts, enter text, then set the word height, the word width, word spacing, line spacing. Click [Ok].
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\

(3 TrueType font: ‘ T Tahoma v width: |S0 o,

O sHix font: &Y Fs.SHX Char space: ‘U mm

Text Line space: |—U mm
["]Enable variable text

Height: |8 mm [ OK { [ Cancel ]

Software also supports variable text, the so-called variable text, the text needs to change as certain rules, output
processing one time, text will change automatically. System supports type text with date and serial number.

Date variables are processing the current system time of the current computer output. Software provides a variety

of date formats for the user choosing.
Users can set date offset, 3 kinds: daily/monthly/yearly. Such as marking the product shelf life  on product

package.
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(3 TrueType font: | B Tahoma v * width: o
O 5H font: &¥ Fs.SHX Char space: D mm
Text| Line space: |0 mm

Enable variable text
l Date v ‘
I
default[20130416 A~

12Hour[HH:MM][03:47]

12Hour[HH:MM][03:47:16]

24Hour[HH:MM][15:47]

24Hour[HH:MM][15:47:16]

American Date[04/16/2013]

Chinese Date[20135F04 A 16 H]

Chinese Date Time[20135F04 B 16

Chinese Time[ 15874743 1681]

European Date Time[16/04/2013p]

European Date[16.04.2013]

Week Year[16/04/2013 15:47:16]
nf —

LICI IS PRV PRSP Tty | T ok Il o}

Offset:

Height: mm [ Apply ] [ oK ] [ Cancel ]

Day vHO ’:

Serial number variables can be digital serial numbers (0-9) or letters (a-z or a-z).
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() TrueType font: | T Tahoma v Width: 0 %
(O 5Hx font: i Fs.SHX Char space: 0 -
| Text Line space: 0 %mm
Extend
Enable variable text
|eriahO v/
' - = [JEnable reset
Prefix: \7
suffi | 1 Enable prefix ZERO
s 00| CJene
Current SN: ‘00007 ‘ Enable SN array
WIhe |t | Mumber Space (1111
: ! G Slale - | ===
X: I |
L Il o =
¥ ‘ ‘ | |=—
Height: ‘8 i [ Apply ] I oK l [ Cancel ] l OK | [ Cancel ]

Suppose you want to processing ABCO001DEF repeatedly, ABCO002DEF, ABCO03DEF until ABC9999DEF such

a set of serial number.

[Prefix]: serial number of prefix, ABC in the example is leading strings.

[Suffix]: serial number of suffix, DEF in the example is back leading strings.

[Start SNTJ: to specify from which serial number to start processing, case 0001 is the starting serial number.

[Current SN]: the current processing to which the serial number, can also be used to specify the current processing
which serial number. If when processing a set of serial Numbers, leaks, processing in one, can be processing, by
specifying the serial number instead of setting start serial number, because in some cases a set of serial number
requires repeated processing, namely to after a certain number, need to return to start serial number to start
processing.

[SN Inc]: to specify the serial number on the number of intervals. In the example, processing from 0001 to 9999 in
turn as serial number, the increment is 1. If you just need to output an even or odd number serial number, you can
set increment as 2.

[Enable reset]: when machining to reset the serial number, serial number will be automatically reset to the current
serial number start serial number.

Case requires repeated processing sequence number from 0001 to 9999, therefore can specify 9999 for reset the
serial number, after when processing the 9999 serial number, text will automatically change to 0001

[Enable prefix ZERO]: without enabling leading zeros, then the system will automatically remove the serial
number of the first nonzero Numbers in front of zero. As the serial number of the case, if there is no can make
leading zeros that ABCOOO1DEF will become ABCI1DEF. But it is worth noting that if we want to output the

sequence number is ABC1DEF, ABC2DEF until ABC9999DEF, we cannot pass will be set to start serial number 1,
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but by eliminating, enabling leading zeros .this is because the set start serial number in a specified sequence

number from which one number, also specifies the number of significant digits, such as to start the serial number is
set to 1, the serial number of the change order is: 1,2,3,4,5,6,7,8,9,0,1,2,3,4,5... The serial number will not change
to 10, because only one serial number of the effective bits.

[Enable SN array]: in the form of arrays, one-time processing multiple serial Numbers.

Such as:

0001 0002 0003 00100011 0012
0006 0005 0004  after machining this batch number, 00150014 0013
0007 0008 0009 directly to the next set 0016 0017 0018

2.6 Object Selection

In the process of drawing and edit graphics, first of all is to select the object. When the object is being selected, in

ER]

the center of this object will have a shaped mark™ x ”, and surrounded by eight control points.

Click menu [Draw] -> [Select], or click Edit Bar Q , switch to status “Select”. Under this status, you can select

object. The following are five kinds of method of selecting:
€ Click menu [Edit] -> [Select All] (Shortcuts Ctrl+A) , select all objects.

€ Click to select single object

€ Select object using select box
Press the mouse and drag, as long as the box come into contact with the object will be selected.
€ Increased select object/minus select object
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Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box to select the selected object.

2.7 Object Transformation

Transformation of object mainly include: object location, orientation and size, but not change the basic shape of the

object and its characteristics.

Transformation of object for users, provides a convenient user interface. User can mirror and rotation through

= WOl o 88

000 within the draw toolbar.

You can also use the Object Properties toolbar, transformation tools to transform and copy the graphics.

%014 |mm (25232 |mm (100 %J 0
0 o1
v/-0.42  |mm F 38.69 |mm/100 %a Ol FrocessNo: .

2.7.1 Object Mirror

Object image is flip the selected object in the horizontal or vertical direction.

Click Edit Bar A » {flip the selected object horizontal.

=]

=1

Click Edit Bar ™ , flip the selected object vertical.

Or through mirror transform tools, to mirror at horizontal and vertical direction, and copy.

2.7.2 Object Rotation

Click Edit Bar O ,» will pop up the dialog of rotate angel setting.
Set rotate angle precisely and click the button [OK] .

Rotate angle(deg) |45 E

|

[ Ok ] [ Cancel ]

If you want to drag rotation, set rotate angle 0, and then “OK”.

Dragging the mouse to adjust the rotate angle, in the dragging process, there will be followed by rotating
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wire-frame outline.

®1-11.4  |mm ¥ 20.578 |mm 100 % | ' o '
¥[20.139 |mm £ 20.794 |mm|100 o a E G B P processno: |

Or directly enter the rotation angle in the Object Properties toolbar.
2.7.3 Place Object

Place the object is to facilitate the view or orientation. The following tools are provided by software:
fad
the page.

K715 e

corner of the object, upper right, lower right, lower left and upper left corner, top right, bottom right, bottom left

, selected object will be placed in the center of the page, that is, the object center coincides with the center of

, selected object will be placed on the page left, upper right, lower right, lower left, upper left

corner of coincidence.

2.8 Object Alignment

Select multiple objects, click aligning toolbar bar
E 8 mww#®2 w1 =0HH
Including:

o o
2 & 0o Left alignment, Right alignment, Top alignment, Bottom alignment

B % 23] Vertical center alignment, Horizontal center alignment, center alignment
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ML Horizontal equidistance, Vertical equidistance

= [ % Same width, Same height, Same size.

The align benchmark object:
For pressing “Shift” to select single object one by one, the last object is the benchmark object.

For box select, the benchmark object is the object which curve number in the last.

2.9 Object View

Move: Click menu [Edit] -> [Movel, or click @\\ . Then hold down the left mouse button in the drawing area,

and drag pan.

Zoom Out: Click menul Edit]->[ Zoom Out], or click ®\ . Each click it, the drawing area zoom out once. Move

mouse to the drawing area and click, each click, mouse position as center drawing area zoom out once.

Zoom In: Click menu [Edit] > [Zoom In], orclick %. Each click it, the drawing area zoom in once. Move

mouse to the drawing area and click, each click, mouse position as center drawing area zoom in once.

View Select: Click menu[ Edit]->[View Select), or click . Move the mouse to the drawing area, hold down

the left mouse button and drag, a dash border box will show in the drawing area, release mouse button, then the

region in the dash border box will display in the drawing area with the largest proportion.

@
View Page Frame: Click menu [Edit] -> [View Page Framel, or click N The page frame will full display.
View Data Frame: Click menu[Edit]->[ View Data Frame], or click O\ . The selected objects will full display

View Feature Data: Click menu [Edit] -> [View All), or click ®\\ .Feature data will be display.

2.10 Important Tool

Here are some frequently used tools. Using these important tools, can make the current document in the
graphics more orderly, and make the processing of output faster.
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2.10.1 Manual sorting and the set of cutting point and the cutting direction

Software provides users a convenient tool for the manual sorting. Select [Edit] > [ Set cutting property] .
Cutting property dialog box will pop up. All with manual sorting, and cut points, cutting the direction of the

settings in this dialog box can be completed.

Set cutting property @

[ ReOrder ][ Reverse ] [ ReOrder ]

NO | Name ~ | NO | Name
Element1

Element2

Element3 |
Element4
ElementS
Elementé
Element?
Elementd
9 Elementd
10 Element10
11 Element11
12 Element12
13 Element13
14 Element14
15 Element15
16 Element16
17 Element17
18 Element18
19 Element19
20 Element20 #H
21 Element21
22 Element22 <<
23 Element23 |
24 Element24
25 Element25
26 Element26
27 Element27
28 Element2a
29 Element29
30 EIementh ¥,

O~ s WM -

ShowPath | l’ il
Py

Show Path: Firstly, check the “show path”, it will display the current graphics cutting order and the cutting

direction.

Change the direction of processing
Click the "edit" / “set cutting direction”, cutting direction into the edit mode.

Then double-click on any position on the selected graphic.

Change the cutting point: Click the [edit] / [setting] cutting, cutting point into the editor mode.
Then select to edit the curves, the node at the point want to set a cut double-click can complete cutting point

changes.

29/81

© 2016 Ruida Technology. All Rights Reserved.



@)

RDVision Laser Cutting Control Software Operation Manual RuibaAcs
2.10.2 Curves Smooth

For some poor precision of curve, their graphics, curve smoothing can make the graphic more smooth,
processing more smoothly.

Click menu [Handle] -> [ Curves Smooth] , the following dialog box is appears.

Curves smooth @

Smoothness J— 94% [CIFitting smooth

| [ Apply ][FuIIFrame] Ok

Drag smoothness, click [ Apply] button, the screen will be displayed before the smooth and smooth curve, easy to
compare.

The black curve is the original curve, after the red curve is smooth curve.
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Curves smooth @

Smoothness J~ 94% [CIFitting smooth

I [ Apply ][FuIIFrame]

You can view the graphics with drag mouse.

You can zoom in/zoom out the graphics with scroll wheel.

Click button [FullFrame] , graphics will shown in the dialog box for largest.

After get satisfied smoothing effect, click button [ Apply] ,curves will processing smooth according to smoothness
settings.

Select “Direct smooth”, you can use another smoothing method.

The choice of smoothing method should be changed with the needs of the actual graphic.

2.10.3 Check Closure

Click menu [Handle] -> [Curve auto closel, or click System Bar [ ,the following dialog box appears.
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Setting close error @

Close error (nm): %il] J

Force to close

Cue

Close error: When distance from the starting point to ending point less than close tolerance, automatic closing of
the curve.

Force to close: Mandatory closure of all selected curves.

2.10.4 Remove the Overlap

Click menu [Handle] -> [Delete overlap] ,or click = , the dialog box appear.

Delete overlap lines @

[TJEnable Overlap error
Overlap error{mm): :

i ok | [ Cancel ]

Under normal circumstances do not select the “Enable Overlap error”. Removing the overlapping lines when
two lines are compared to a good degree of coincidence. If you need to delete overlapping lines, you should select
“Enable Overlap error”, and set overlap error. Generally do not overlap error set too large, so as to avoid accidental

deletion.

2.10.5 Combine Curve

)
Click menu [Handle] / [Combine Curvel, or click =t ,the following dialog box appears.
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Setting combine error @

Combine error{mm): Fm—‘

[ Ok ] [ Cancel ]

The software automatically merges curves in the selected curves, when these curves merge tolerance is less than the

setting of combine error.

2.10.6 Data Check

After the selected graphic to check, click the [menu] - > [Handle / [data check], or click toolbar icon , the

system will appear the following interface

Data check @

Close check end

Check close Find unclose curves:3
e Self-cross check end
[Jauto close Error(mm): I_J Find self-cross curves:1
Cross check end
Check self-cross Mot find cross curves

Overlap check end
Mot find overlap lines

Check cross

Check ovetlap

SRS |
[(]Enable error Error(mm): | O | Check

Data checking, integrates the closure checking, since the cross check overlap, cross check and data checking. Users
can choose according to need to check the item, after data detected problem, in the dialog box on the right side tip
problem has been detected and at the same time will question the graphics in the selected state. Repeated checking

- > eliminate errors - > check process, until all the data are conform to the requirements of the processing.
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2.10.7 Generating parallel lines

Selected to generate parallel lines of the data, click the [menu] - > [handle] / [generated parallel lines], or click the

O

toolbar .

Offset poly @

Offset{mm): |0 1 mm [[]pelete artwork

&) In ) out () auto Infout

[ Ok ] [ Cancel ]

Red line is the original graphics, green line is the inward graphics.

2.10.8 Model Auto Hide

In feature edit mode, hidden the cutting data; in cutting edit mode, hidden the feature data.

Help @

v System Bar

v System Status Bar

v Draw Bar

v Cut Property Bar
Arrange Bar

Model auto hide
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Chapter 3 System Settings

Before output graphics, required to determine whether the system settings are correct. Click menu [ Config] ->

[ System Setting]

SR AN Handle ()

File Para Setting

Page Setting
Password Setting

3.1 General settings

Setting

General settings | System Info |

s o B e poancters N
Axis ¥ Mirror Idle speed(mm/s)  200.000
Axis ¥ Mirror Idle Accimmy/s2) 3000.000

Start speedi(mm/fs) 20.000
Min Acc(mm/s2) 400.000

[]small circle speed limit Max Acc(mm/s2) 3000.000

e o) Cutting mode Normal Cutti
1.100 25,000 2
2.100 35.000 Acc Mode S mode
3.100 40,000 &= Home para
4.100 45,000
5.100 50.000 Horne speed(mmjs) 20.000
6,100 55.000 Auto home X Yes

Auto home Y Yes 3
< | > . l Vﬁl

Axis Mirror
Generally, axis direction mitror is setting based on the machine actual location of limit.
The default coordinate system is Descartes coordinate system; usually the zero point is in the bottom left. If the
zero point is on the upper left, then X-Axis do not need to mirror, but Y-Axis need to mirror.
If the zero point is on the upper right, then both X-Axis and Y-Axis are all need to mirror.
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One simple method is to check the coordinate arrow position in the graphical display area according with the

machine actual origin position. If not, you should modify the direction mirror.
Small Circle Speed Limit
On processing work, the software automatically determine whether the current round need to limit speed ,then
according to the diameter size of the circle to determine the speed. If parameter is proper, the small circle cutting
effect will be greatly enhanced. Click button [Add), [Delete] , [Modify] to configuration.

The speed rule of small circle is less than the speed of the rules limiting list of small round circle of minimum
radius, output as the corresponding speed of minimum radius circle.

If the speed greater than maximum speed limit lists the speed round, the speed only associated with the speed
of the layer.

If the speed is in the list, set the output speed as list.

If the request received by limiting layer parameters faster than the setting speed in the layer, output as the layer

speed.

® Add backlash
Click the “Add” button, the screen will pop up the following screen.

Small circle speed 1... @

Diameter{mm) D

Speed{mmj's) ‘TU 7—“

[ Ok ][ Cancel ]

Set speed and diameter; click “OK”, the value to be inserted into the list of backlash.

® Modify backlash

Double-click the left mouse button scanning (reverse backlash) need to modify the small circle parameter, then

Small circle speed 1... @

Diameter{mm) \El] \

the pop-up screen shown as below:

Speedimmys) ‘.25 ‘

[ Ok ][ Cancel ]

In the interface, you can modify the current speed of the corresponding backlash.

® Remove backlash
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Click the small circle be deleted item, then click the [Delete] button.

User Parameters

Idle speed: this parameter decides the max. speed of all lines not emitting beams during the operation of the
machine. This parameter should not be lower than the lower of the jump-off speed of the X-axis and Y-axis and not
exceed the higher of the max. speed of the X-axis and Y-axis, if the user setting is illegal, the controller will
automatically take this parameter in the above-mentioned rang; A higher idling speed can shorten the operation
time of the entire figure, while excessively higher idling speed may cause dithering of the tracks, therefore, you
should take all relevant factors into consideration when setting.

Idle Acc: The acceleration speed of idle walking, matching to the idle speed, if you set too slow, the actual speed
may not reach the setting value; if too fast, the mechanical structure may not withstand and cause to dithering.
Generally, the idle acceleration is a little bit higher than the cutting acceleration.

Cutting Acc: the acceleration of cutting speed (cutting speed is the layer speed of the layer parameters).

Turning speed: the minimum speed at the turning corner in cutting process. You can reduce the turning speed
properly when processing the jagged material.

Turning Acc: it should match the turning speed.

Cutting mode: there are 3 kinds of cutting mode: precision cutting, fast cutting, ultra-fast cutting. The user can
choose it according to the actual applications.

Home speed: This parameter determines the machine speed of returning to origin. When the machine is larger
breadth, to set the higher reset speed, but cannot too larger.

X, Y, Z, U Auto home: All the single axis can be set whether should reset when power-on.

Delay before feed: when using the feeding device, a single delay before feeding, the user can arrange such as
sorting material at this time.

Delay after feed: refers to material feeding device to reach the designated position, which need stability for a
period of time before processing.

Backlash X, Y: compensate the backlash caused by the machine drive.
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3.2 System Info

Setting

| General settings | System Info |

Vendor password:

Mainboard version:

l [ Input

’ Upgrade

Close

For the information on the controller operation, manufacturers need to enter password to view parameters.

© 2016 Ruida Technology. All Rights Reserved.
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Setting

| General settings | System Info |

Total on timethour:min:s): 1

Total processing time{hour:min:s):

Previous processing time(hour:min:s:ms):

Total processing times:

% Total traval(m):

|
| |
| |
Total laser on time{hour:min:s): { }
| |
|
|

¥ Total travel(m):

Mainboard version:

‘ Upgrade

Total on time: The total time of motherboard working

Total processing time: The total time of processing, including the time of jump moving.

Previous processing time: The time of the last processing

Total laser on time: The time of the laser processing

Total processing times: The number of completed processing, not include the processing forcing to end.
X total travel: The total travel of motor X.

Y total travel: The total travel of motor Y.

Mainboard version: The version of the current controller.

The function of upgrades:
If the board has additional features, the manufacturers will provide the update file (*. bin format), the user can
load the upgrade file to upgrade the motherboard. After upgrading, you need to click on the control panel "Reset"

button reset the motherboard before normal use.
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Chapter 4 Camera Management

4.1 Camera parameters

Click [camera para] on the operation panel button, can appear the following camera parameters Settings dialog
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Camera para S

Camera param

Contrast:

Gain:

Wait time(ms): 0 [ Color mode
Rotate angle: [ | camera fixed mode

Camera calibration
1 Speed: 1000 mmjs Power:  30.00 %

[ Cut cross H Calibration

E Width: 100.0 mm Height: 100.0 mm

Speed: 100.0 mm/s Dot power: 30.00 %

[ Go scale H Dot para ][ Dot H Correct

3 Redo 1st step Cut cross

I.| Manually correct offset{Not recommended)
X: 0.000 mm Y: 0.000 mm

Ratio; 1.000

[ Reset H SaveAs H Load

The adjustment of the camera on the hardware mainly by adjusting the aperture and focal length to adjust the

quality of the image but the camera is installed, can't adjust. Usually adjust the environment light.

The camera parameters adjustment in the software:
Contrast: Mainly through adjust the background color and contrast material color difference to fine image quality.
Gain: the brightness of the image magnification.

Exposure: the longer the exposure, the higher of the image brightness.

. Explosure: . .
Click can perform automatic expose operation.

“Contrast” and “gain” are both to deal with image data. So when image is in dim, firstly adjust the light source

(lamp on the camera )and [ Exposure] , if still cannot get the desired effect, to adjust brightness, contrast, gain.

42181

© 2016 Ruida Technology. All Rights Reserved.



@)

RDVision Laser Cutting Control Software Operation Manual RuibaAcs

Stabilization time: stability time associated with the machine, the machine inertia large, after the high speed
movement stability will take a long time. When you take a photo and needs a stable vision. Recommended value is

300 milliseconds.

Threshold: when user extracts the characteristic curve, you can set three options (Low\Medium\High) for you. It

can control the density of characteristic curve. The lower the level, the more the lines.

4.2 Camera Calibration:

4.2.1 Cross Calibration

Camera para |

Camera param

Contrast: il b—O %
Gain: = 930 |
13.0 | 9%

13.0 |9

sturation {1 80.0 |9
Explosure: {} 26,0 o
["] continuous AE Target: 500 9%

Wait time(ms): 0 [] color mode
Rotate angle: ("] Camera fixed mode

Camera calibration
1 Speed: 1000 mmfs Power:  30.00 %

Cut cross || Calibration

E Width: 100.0 mm Height: 100.0 mm

Speed: 100.0 mm/s Dot power: 30,00 %

{ Go scale H Dot para H Dot ][ Correct ] ,

a Redo 1st step Cut cross

L' Manually correct offset(Not recommended)
X: 0.000 mm Y: 0.000 mm

Ratio; 1.000

[ Reset ][ SaveAs J[ Load J

43/81
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[Speed 1 : In the process of camera calibration, laser head moving speed or when cutting cross or dotting.

[Power ] : The camera calibration power when processing.

[ Cut Cross] : Click the "cross cutting", the laser will quickly cut a cross.

[ Camera Distance Calibration] : Cut a cross, then move the camera view cross center to coincide with the cross
center, click "camera calibration". System will calculate the offset from camera view center to the center of the

laser head.

4.2.2 Dot Calibration

Camera para X )

Camera param

Contrast: { D0 %
Gain: { 93.0 %
13.0 | o

13.0 |9

Saturation ] 80.0 |9
Explosure: {1} 26.0 9

("] continuous AE Target: 50.0 9

Wait time(ms): 0 [ Color mode
Rotate angle: [ | camera fixed mode

Camera calibration

1 Speed: 1000 mmjs Power:  30.00 %
Cutcross || Calibration

E Width: 100.0 mm Height: 100.0 mm

Speed: 100.0 mm/s Dot power: 30.00 %

Go scale Dot para Correct

a Redo 1st step Cut cross

I.| Manually correct offset{Not recommended)
X: 0.000 mm Y: 0.000 mm

Ratio; 1.000

[ Reset H SaveAs H Load

[ Width ): The width of the camera view, after camera installed, users fill in according to the actual data, it would
be larger than the actual value.
44/ 81
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[ Height ] : The height of the camera view, after camera installed, users fill in according to the actual data, it

would be larger than the actual value.
[ Interval] : Emitting time when laser dotting a point.
[Space] : Set the distance between two points.
[Dot] : Click on the "Dot" button, the system will be based on user fill in the camera view the size, print out the
M * N could be covered with the camera point of view.

- |[® %)

Fled) L) Dree@) Configl) Hedlel) Viewldy) X0

200 Aaaqanane smiEHBYOM]B =i oir

. Fracess | Modd

.
1 B cnonc |
‘s ) . . Camera para 3

i Camera param
/- ’ . Contrast: 1} 20 %

. . o Gain: - 930 %
/ 130 |[%
h . 13.0 | %
=l . - 0 80.0 | %
- Explosure: { 6.0 %
S| ] Continuous AE Target: 00 %
ﬂ Wait tme(ms): 0 {7] Color mode
x ) * * * *| Rotateange: -_ [ Camera fixed mode
& . . ] L * | Camera calbration

' o . o1 speed: 1000 mmis  Power: 3000 %
'e Cutaoss || Calbration
E : ’ : ’ & c E Width: 100.0 mm Height: 100.0 mm
ol ¢ » . &£ Speed: 100.0 mm/s Dotpower: 30.00 %
53 ¢ s e e e e e e e e s e e e e e s o [coscae [ Dotpara |[ Dot ][ comect ]

b & ® W w- N w & e o e e o e e e e e e« | redoststepCutaross

® o e o . . . ° . o . . . . . . a o . . . + | Y Manualy correct offset(Not recommended)

X: 0.000 mm ¥e 0.000 mm

Rato: 1000

[ Reset | sovers || 1o |

B81mm

e WIGHATREN St . #OBEL YT RAM PO TETS o Tatal T.000 (8 31 T0% Simela T.000 03 06 125 Verk vas 4 T =T4 100ee Y 3T (500w

[ Correct] Laser puts lattice points in the middle of camera visible area, click "correction" button, the camera
calibration can be realized manually. The following figure:

R ARIE S 2=456, SCRRANIE 2 81=454, R FshiE1E?

| Rw |[ Tw |
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© 2016 Ruida Technology. All Rights Reserved.



@)

RDVision Laser Cutting Control Software Operation Manual RuibaAcs

- [ X

Fled) L3 rer@) Configl) Nedlel)) Viwll) X0

o0 aaaceaqa smHKFEGYSMEImE =l g5 ol

. . . - . . . . Froceds | Moded
"S Camera para i
) Camera param
/| - . . . " * | Convast 0 20 %
2 - ) o= Gain: - 90 %
30 %
o I = . . o o 30 |%
‘ & & o & e 0 800 %
Explosure: { 6.0 %
Tt T T T Blcotaos ke Target: 00 %
e R S~ (13 = Waittme(ms): 0 Coior made

. B * | Rotate angle: uj | Camera fixed mode

= . . * | Camera calbration
1 Speed: 1000 mm/s Power: 3000 %

HBcoads XS0

' S (L cutross ]| Colbraton |
C Tttt R ek 1000 e Heght:  100.0 mm
R y ® & = ¥ {§ ¢ Speed: 100.0 mm/s Dotpowe: 30.00 %
b s & o . e o | e v v 4 e e 4 e o +| T RedoiststepCutaoss
R & I8 -

o . . . . q Manually correct offset(Not recommended)
X: 0,000 mm Y: 0.000 mm
Rato: 1.000 |<<< )

i [CReset ][ sovers ][ tomd |

I
J

-

——— ORI I M Sl MO BTN ST aintaatis N e Weiad W LA LD a PR BN P ARG PE A b s 8 Wova ANl W AT fenLl

If calibration is successful, system prompt will pop up “calibration success”;
If failed, the system prompts “calibration failure”. So you need to calibrate repeatedly until success.

Note: After dotting calibration, suggested that do “camera distance calibration” again.
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Camera para X )

Camera param

Contrast: {1 ho %
Gain: {1 93.0 o

' 13.0 |op
Lo 13.0 | o
Saturatior {1 80.0 | o
Explosure: {} 26.0 o
("] continuous AE Target: 50.0 9

Wait time(ms): 0 [ Color mode
Rotate angle: [ | camera fixed mode

Camera calibration
1 Speed: 1000 mmjs Power:  30.00 %

[ Cut cross ][Calibration ]

E Width: 100.0 mm Height: 100.0 mm

Speed: 100.0 mm/s Dot power: 30.00 %

[ Go scale ][ Dot para ][ Dot ][ Correct

3 Redo 1st step Cut cross

I.| Manually correct offset{Not recommended)
X: 0.000 mm Y: 0.000

Ratio: 1.000 <<<

SaveAs

[X1 , ['Y] This parameters setting is to compensate the camera distance.
[ Ratio] There is tiny difference in height between the calibration and the actual matched plane. You can improve

cutting precision by this parameter.

Notice: When calibrated many times, cutting precision still cannot meet the user needs, you can adjust parameters
of [X], ['Y]), [Ratio] manually in step 4.

47181
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4.2.3 Calibration file management

Camera para ||

Camera param

Contrast: {1 0.0 |o%
Gain: { 250 o
Explosure: i 20.0 =
[] Continuous AE Target: 90.0 %

Stabilization time: 300  ms

Camera calibration

1 Speed: 100.0 mm/s Power: 30.00 %

[ Cut cross ][ Calibration

E Width: 100.0 mm Height: 100.0 mm

Speed: 100.0 mm/s Dotpower: 30.00 %

[ Go scale ][ Dot para ][ Dot ][ Correct ]

3 Redo 1st step Cut cross

I.| Manually correct offset(Not recommended)
X: 0.000 mm Y: 0.000 mm

Ratio: 1.000

[ Reset H SaveAs ][ Load ]

[ Save As] : After calibration successfully, the user can “save as" to save the calibration files under the specified
directory, and set the file name. Interface as shown in below figure:

48181
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Save as... g]
BEED: DWW v Q2 @
THEW: | | [Bre |
BEFZB @ [Calibration files (x. cor) v i

[Load] : In normal circumstances, there is no need to do calibration operation every time by software. Users can
load the existing calibration file, to implement calibration function.
When the camera and the machine position are unchanged, just need to load the existing calibration file. Click
"load file", pop up a file dialog box to find the file need to calibrate, and click "open" button to complete loading

operation. Interface is as follows:

49/ 81
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Open @
SHEEO: | O Wi v Q2@

IHE W) [calibration ‘ | T @) I

ILZER (1) ]Calibration files (k. cor) v‘ il
(IR REFRITF ®)

[ Reset calibration]: When the camera calibrated, the results are not proper. Users need to correct again. Before
the next correction, user must clear the calibration object. Then click the “Reset” to clear the calibration object.
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Chapter 5 Model Management

5.1 Create Model

Move the center of camera view to the actual image center, then click [ Create] button, system will prompt user to
enter a model name, as below figure showed:

BRGH: | |

[ ok | [ Cancel ]

Enter a non-existent model name, then click [OK ] , a model has been created successfully.

5.2 Extract Features

5.2.1 Select Feature Region

The model editing mode switch buttonlEI

mode”.

, which can be switched between “ feature edit mode ”and “Cutting edit

In “feature edit mode”, press the right mouse button, dragging to draw a green rectangle (can draw multiple times).

The green rectangle area is feature region.

Notice of feature region selection:

Graphics of the feature region, it must be a unique identifier of the unit target object.

In the feature region, the color of Graphics and background must be different.

The larger the feature region, the longer the matching time. So don’t choose too large region.

If big splicing model, the feature region cannot be located on the splicing backlash.

51/81
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File(F) Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)

2ooacaaaaa smHHBERETOM %!
Model edit :

Searchnum  Offset Dislocation

= IE 00,000 0000 [ custom |
v 1 100.000  0.000
B oo | () [ (e

E=A -

[Z] Enable valid zone
[Zstep mode Cutting after all -
Specd(nmfs): 200.0 | Retum positon:[Orign v

cEaEX=00YN\ vwEE

oo
oog
Boo
- WEERFREES  BUFBEREE1024'768 HEES - Total T:000:05:04:653:Single T:000:00:17:301:Work num:57 X:45.032mm,Y:-24.454mm
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5.2.2 Set Model Parameters

NO Name Worked count [M]
Clean all
Del all
[ Create ] [ Open ] [ Save ]
| Copy |[  splicng || Importimage |
[ B RHELR ]
Model setting
@) Featurel Feature2 Feature3 Featur
Smooth: 1 80.0 %
Similarity: 50.0 % Qverlap: 20.0 %
Angle: | 180.0 °F
Match num: 1 [¥] Speed match mode
Timeout: 1000 ms [ |Share edge

@)

RuiDa ACS

[ Smooth coefficient ]: The higher the smoothing coefficient, the less the scattered points of feature region be

extracted. (Detailed Description please refer to chapter 5.2.3) .

[ Similarity J: The matching scores of model and actual graphic, the higher the scores, the more the similarity. The

similarity setting directly affects the matching quality.

[ Overlap ]: The overlap percentage of two target object envelope rectangular. This parameter controls whether

targets can be identified when overlapping.

[ Match Angle ]: The model rotation and searching angle range. For example, the value set to 180° . In the

matching process, the searching angle range is -180° ~180° . To set the search angle according to actual needs.

The larger searching angle, the longer matching time required. If the user does not need to set this parameter, and

you should remove the option.

53 /81
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As shown in the following figure, there are two opposite triangles. If use a model matching, you must enable the

Angle: 180.0 | © .

match angle and set the search angle as 180° So that finding the two opposite triangles

when matching. However, in the process of rotation match, increase the amount of calculation and slowing the
speed of matching. And reducing the matching accuracy at a certain. Therefore, in this case, it is recommended

that using multi-model to match.

.V‘V.’ f

(VAVAY
AVAVAY

[ Match test]: Match the current model and the target image of camera field view, test results will be returned as

results-interface. When the matching results are not satisfied, adjust the similarity until the matching results

satisfied.

5.2.3 Feature Processing

As shown in below figure, the red lines in the green rectangular box are feature curves. There are some excessive

scatter-point or curves, user can improve the smooth coefficient to reduce the number of feature curves.

54 /81
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(Smooth 50%) (Smooth 100%)

If users want to delete some curves, in “ features edit mode”, press down the left mouse button and drag to draw a

rectangle, and select the curves need to be deleted. Then press the “Delete” to delete excessive curves.

[ Screen Feature curves] In “features edit mode”, click system toolbar icon . Select feature curves which

length is less than the setting value.

5.3 Model Edit

5.3.1 Extract Feature Contour

First, select a edited model (check the model). Click the icon|§| on toolbar. In “feature edit mode”, the

top-left of main-view window will prompt: M Od el ed it m Od ;

Press down the right mouse button and drag to draw a rectangle, the red lines are feature curves. If the feature
curves are not obvious enough, users can adjust the ambient brightness to make a clear outline of the image. Also
can adjust smoothing coefficient, get better quality feature curves. As shown below:
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& .-[Blank] - e
File(F) Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)
‘oo aaaaaqqsmHEETONR %Y
[GIModel edit
(%]
S
7 Model settings X
/7 NO Name  Worked count || Saveimage
PR 0
s | Cgemnal
=
)
o
Codal )
X [ create J[ open [ save |
[ copy ][ spigng ][ importimage |
Alj
> Model setting
O ©) Featurel | Feature2 | Feature3 | Featur
oog
888 Ssmooth: f 800 %
Similarity: 50.0 % Overlap: 200 %
Angle: [150:0] ° [
Match num: 1 (V] Speed match mode
Timeout: 1000 ms [~]Share edge

- EEEAEERRES  BUEEETREA1024'768 HEES - Total T:000:05:04:653:Single T:000:00:17:301:Work num:57 X:124.444mm,Y:46.000mm

5.3.2 Edit Cutting Curve
[ Contour] In “model edit mode”, feature curves has been existed. Firstly select feature-curves, and then click

system toolbar icon % , generating cutting curve contour automatically. Then edit cutting curves contour in

“cutting edit mode”.

[ Manual Drawing Cutting Contour ] In “cutting edit mode”, edit cutting curves please refer to section 2.4 .

The blue lines are the cutting curves. As shown below:
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Fled) L3t Drwr@ Configl) Hedle) Viewld)

2O O R Q. QA4

[;J Cutting edit mode

bl

o BB E Iy ONR ot~

ree §

Haly

\
b v 1 1 0 [(Gean count |
Cenal |
o> Sel al
Invert
QI Delete
X —osm
/t‘ Create | Open '\ Save
y Copy [ spiong ][ Importimage
P |
< AR
E Model setting
“ | Advance... |
o0
88
Smooth: } 800 %
Smiarity: 50.0 % Overlap: 200 %
o
Angle: | 1
Match num: 1 V| Speed match mode
Timeout: 1000 ms || Share edge

=== »Yalcine t3 nra the Later syuten of cotting Pregose the display area 102407 Total T 000 03 11 701 Siagle T €00 O1 .08 175 Nork nor € YU 2100, Y 16 800

[ Node Edit] In “Cutting edit mode”, click the node edit tool ’ b

node drag in node edit mode.

© 2016 Ruida Technology. All Rights Reserved.
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Dragging node to change the graphical outline;

Double-click the left mouse button on the contour curve to add a node;

Double-click the left mouse button on the node to delete a single node; choose multiple nodes and press the
“Delete” key to delete multiple nodes.

After editing, the picture as shown below:
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User can adjust graphic outline by node edit. Graphic contour transformation processing can meet the user's needs.

Details please refer to sections 2.6 and 2.9.
Support importing contour drew by other graphics software (AutoCAD, Adobe Illustrator, CorelDraw) drawn to the

model. Details please refer to sections 5.3.3
5.3.3 Import Cut Contour

In “Cutting edit mode”, import cut contour.
In “model cutting mode”, click [File] -> [Import] , “open file” dialog box appeared. Next select the file and then

click [Open] . As shown below:
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Import
SHEEQ: | 5 ;ealiiideo130410
D RIFEAFB 130418

=11, a1
BCont our. dxf

Preview

a2 ) Contour. dxf
IC42ER (T): | Supported Files v il

Import file to the model, drag the contour curve to right position. Fine-tuning can also be achieved by the top,

bottom, left and right keyboard keys. Details please refer to section 2. 3

5.3.4 Copy Cut Contour

You can do operation of copy the cut contour between different models.
First of all, select the cut contour curves and press down “Ctrl+C” in “Cutting edit mode” of model A

Then, switch to ‘Model B’, press down” Ctrl + V>, the copy operation is completed.
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5.3.5 Multi-models

In the same target image contains different graphics, this software provides multi-models matching-search function.
Its implementation steps:

Firstly, create two models;
Secondly, checking two models at the same time when model matching.

There are two opposing triangles in the following figure.

VAVAVAV/
VAVAVAV,
VAVAVAV/

_J\ J\ J\ [
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Create two models as shown below:

File() Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)
2 |mmje 2

é@e @§®\G&Q%Q®%O\\'ge4r'||§’§@ﬁgﬁo_" 56 | mm F [34.146 | mm| 100.0 %

Model edit . 3 X: 0.000
Y:  0.000
U: 10000 000

Model settings

NO Name  Worked count | [ Saveimage
1 1 0
e

(Cosee

Del all

71 |mm|_100.

F

P4

J

[ Create ][ Open ][ Save

[ copy ][ spidng ][ Importimage |
BERERER

Model setting

@ Featurel | Feature2 | Feature3 | Featur

cadX®0OY N\ vwFH

oo
oog
ooa

Smooth: {1 800 %

Similarity: 50.0 % Overlap: 20.0 %

Angle: [180.0 °

Match num: 1 [¥] Speed match mode
Timeout: 1000 ms [C]Share edge

-— *Welcome to use the Laser system of cutting Propose the display area 1024°768 or higher *-—- ngle T:000:00:17:301:Work num:57 X:20.443mm,Y:-62.787mm

Then, check two models can be achieved multi-models matching. In the actual matching process, the inverted

triangle matches with the inverted model and the upright triangle matches with the upright model.
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5.4 Contour and Layers

5.4.1 Contour Qutput Parameters

In the same batch of graphics processing, the different graphics need to set different processing parameters.
Processing parameter corresponds to the color layers. Layer parameters are the contour of output parameters. Layer

parameters can be modified according to user needs. As shown below:

Flle(F) EditE) Draw(D) Config(S) Handle(W) View(V) Help(H)

‘doolaaaaaaqsmHEEVSHRE

BModel edit
_ Searchoum  Qffset  Dislocation
7 :
/ Model settings
NO  MName  Workedcount
”x @i 1 o
|| w2 2 g
)
fl
b 4
[ create [ oOpen ][ sae |
v C_coor. ) spicng._ ) (_importimage.)
=
= BEERHER
E Model setting
D Normal __Advanoe, =
oog @) Featurel Feature2 Feature3 Featur
BeR
Smooth: i 500 %
Similarity: 50.0 % Overlap: 20.0 %
Ange: [1800] °
Match num: 1 [¥] speed match mode
Timeout: 1000 ms [7]Share edge

X:20.443mm,Y:-62.787mm

— *Welcome to use the Laser system of cutting,Propose the display area 1024768 or higher *---
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Layer Parameter @

R
B
|
=
=
P
=

|

[«

Load parameters from library

Layer: -

Is Output: | SIS ~ |

Speed(mm/s); (100 ' [Jpefault

If Blowing: |Yes

Processing Mode: | Cut v

Min Power(%) L‘ (] Default

Max Power(%) |30

Seal: (0.000 mm

Open Delay: ms

I

Close Delay: ms

Laser through mode

Advance...

[ Ok ] [ Cancel ]

5.4.2 Set Contour Layer

Different layers with different colors. Different layers have different parameters. In the output of the processing,

different contours output in the same processing parameters, just all contours set to the same color (That the same

layer) .

Different contours output in different processing parameters, just set contours to different color (That the different

layer) .

)

RuiDa ACS

[ Set Contour Layer): In “Cutting edit mode™, select the contour. Click the layer button. As shown below:

Layer Mode Speed Power

B 10,000  30.000

QOutput
YES

Layer list

|.-.. ...... » Layer button

Note: For more details about layers, please refer to section 6.1.1
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5.5 Splice Model & Multi-Features

Firstly, click [Splicing] , the follow dialog box appeared:

1: | 0.000 0.000

[]Positioning laser head position

2:| 0.000 0.000 .Set point2 ][ Start H Stop ” Update ] [ Cancel ]

The splicing operation requires two coordinates of graph diagonal.

Secondly, move the center of camera filed view to upper left corner of graphic. Then click [Set point 1]. As shown
below:

Thirdly, move the center of camera filed view to lower-right corner. Then click [ Set point2] .
As shown below:
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Fourthly: Click [Start] , splicing results as shown below:

Splicing

1:| 316.634 | 103.855 |[ et pointl | []Positioning laser head pasition
2:|577.435 | 249733 || Setpointz | [ stat || stop || update | [ cancel |

Fifthly: If need to update the local area, click the left mouse button and drag to select area need to update. And click
the "Update” button.

Click "Ok” button when splicing completed. It will create a mode automatically.
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Splicing graphics as follows:

File(F) Edit(E) Draw(D) Config(S) Handle(¥) View(¥) Help(H
@ I N X | {mm mm %ﬂ@ e
00 aaaaaaqsmHHEESSM; BT QE O
GModel edit mode :
[k ‘ 1 maomao 2
5
Splicing
A
7
7‘\ L | Import image
Mode! setting
I:I Smooth: |100.0 | % MlModel type:|Normal v
Similarity: (25.0 | % Hormal
(o] il |l ©Featurel Do
Overlap: (0.0 | % 2 3 Points
{FI Angle: [180.0 | © 4 Poinks
X IP:Default
- -
=
=~ *- pas Match test Cut test
|
.
o o] |
ooo
ooo
ooo [[Jstep mode [JEnable valid zone
Speed(mms):| 200.0 [ cutting after search over

——x O EREEEEIE G RS TR 10244768 BB B *— [Total T:000:00:00:000:Single T:000:00:00:000:Work rum: K:161. 617nm, Y:32.91dnn |

[ Multi-Features ] For a larger model (Splice image) , you can choose many of its features to locate. In the

[ Model type] parameter sets the number of characteristics: normal, 2 points, 3 points, 4 points.

Note: You can create Multi-Features mode by importing scanning graph, details refer to “5.11 Import Image”.

5.6 Save Model

User need to repeatedly use the model. The model should be saved as model file. Click [ Save]and enter file name,

model will be saved automatically.

5.7 Open Model

User need to open model file, click [ Open] and select the file that needs to open. Then click [Open] button on
the open-dialog box.
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5.8 Delete Model

Select the model that needs to delete, Click [Delete] button that the model will be deleted.

5.9 Delete All Model

This operation button will delete all model, click [Del all] button that all model will be delete.

5.10 Save Model Image

Save the model image as a picture file, the picture file can be imported into other graphics software. Draw Cutting

contour and save it as a data file. Our software provides import operation for cutting contour data.

5.11 Import Image

Splice larger image, also can use scanner to scan the larger image. Click the [ Import Image] function button to
import scanning graph and create Multi-Features model.
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Chapter 6 Processing Management
6.1 Set Processing parameters
6.1.1 Layer Parameters & Layer Button
¥ork para
I Layer Mode Speed Power
I 10.000 30,000
Layer list

.... ...... Layer button

[[JEnable feeding
Feedingnum:| | Feedinglength: i’__' _____ | mm
Feeding speed: ; : mmy's
Path optimize

Block height: [20.0 |mm ] Inside to outside

Dir: | Up to bottom + |

Match num: } 100

[]speed match mode

Search type: | Stadard arra v

Clear work info

[ Layer List]: Display layers parameters.
[ Layer Button): Select the curve that needs to set layer color, and then click layer button. It can set layer color.
[ Modify Layer Parameters ]: When modify the layer parameters, double-click the left mouse button the

corresponding row in the layers list. It will appear layer parameter dialog box.
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Layer Parameter @

| Load parameters from library I

Layer: -
Is Qutput: v?
spesduash @ []Default
If Blowing: |Yes [+]

Processing Mode:

Cut v
Min Power(%) |30 (] Default
0

Max Power(%)

I

Seal: |0.000 mm
Open Delay: ms

ms

Laser through mode

[ Ok ] [ Cancel ]

[

Close Delay:

<

User can modify the parameters in the “Layer parameter” dialog box. You can load parameters from parameter
library if parameters file have been saved, previously.
Click [Load parameters from library)], appears follow dialog:
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Load parameters from library @

Parameters library:

(Default Laver:Is Qutput:yes

If Blowing: Yes
Processing Mode: Cut
Speed:100.0
Laser1:30,0%--30.0%
Laser2:30.0%--30.0%

Add parameter

Parameter name:
Default ’

Parameter note:

o [ Save as J
[ Delete ]
[ Load ] [ Exit ] { Ok ,I[ Cancel

Select parameter file from the library, and then Click [Load], complete the parameters load operation.
You can also save current parameter to file. Click[ Save as], and then enter the parameter name and parameter note.

If you want to delete a parameter file, you can select the file and click [Delete] .
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6.1.2 Feeding

| Layer Mode Speed Power Qutput
T 10.000  30.000 YES

[[JEnable feeding

e

L mm

Feeding speed: l | mmfs || Feeding after

s
Feeding num: | ' ! Feeding length: ’_

Path optimize
Block height: |20.0 | mm Inside to outside

Dir: | Up to bottom + |

Match num: |100 3 []Speed match mode

Timeout: |300 |ms

—
Search type: |Stadard ana (¥ |

Clear work info

[Enable feeding): Automatic feeding

[ Feeding num]: Set the number of feeding.

[ Feeding length): Set the length of feed each time.

[ Feeding speed]: Set the speed of feed.

[ Feeding after processing ]: All processing are completed, whether user needs to feed. If you need, check this

option. If no, do not check this option.
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6.1.3 Path Optimize

’ Layer Mode Speed Power Qutput ‘
\
|
\
\
\

Cut 10,000  30.000 YES

[]Enable feeding
Feedingnum: | | Feeding length: }__'____ | mm
Feeding speed: } | mmfs

Path optimize
Block height: [20.0 |mm ] Inside to outside

Dir: |Up to bottom + |

Match num: } 100 | []speed match mode

Timeout: | 300 ;ms

==
Search type: |Stadard arrar v

Clear work info

[ Path Optimize]: Only local optimize the matching data results once.

[ Block height J: Optimize the processing data, the block can reduce the difficulty and optimization efficiency. The

overall data is divided into a plurality of partial data blocks according to the block-height. In the optimization, the
local data block as a unit for optimization.

[ Inside to outside J: If there is inclusion relationship in the cutting path, user can set the processing path to
“inside to outside”. (check “inside to outside”) .

[Dir]: In the path optimization processing, the direction of setting is the overall path direction.
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6.1.4 Speed Match Parameters Setting

‘ Layer Mode Speed Power Qutput ‘
\
|
!
}
\

[]Enable feeding
Feeding num: L _: Feeding length: }__'____ J mm
Feeding speed: } | mmfs
Path optimize

Block height: [20.0 |mm /] Inside to outside

Dir: |Up to bottom + |

[]speed match mode

Timeout: | 300 ;ms

|
Search type: |Stadard arra’ v]

Custom angle
Dynamic search

[ Match num] In the effective filed of camera view, t he total number of existing matching-object.

[ Timeout] When you set the parameter of ‘Match num’, you need to set this parameter to control matching time.
In process of matching, in order to avoid waiting for a long time or lacking of time to cause the failure of target
image matching. This parameter is mainly affected by the model characteristics of complexity and the target
quantity.

[ Speed match mode] When select this option, system will take fast algorithm in process of target-matching.
Notice: when select the option Speed match mode’, the Model parameters option ‘Angle’ must disable.

[ Search type ] Define searching type. Options include “Standard array”, “Custom angle”, Dynamic search. It

b

Mum Offset  Dislocation

x:[ 1 H 10,000 H 0.000 Im
combines with M ! H iy H 0.000 “ Path Browse |

to work.
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Process | Model

6.2 Processing Status Parameters

X: The laser head current position on the X-axis

Y: The laser head current position on the Y-axis _ Num  Offset Dislocation
. . J o1 10.000 | 0.000
U: The laser head current position on the U-axis il | ]
vl 1 10,000 | 0.000
O [ Back ] [ Simulate ]

Total T:000:00:00:000:Single T:000:00:00:000:Work num: X:78. T59mm, Y:48. 949mm
[Total T): The total time of processing workpiece.
[Single T): The time of processing one workpiece.
[ Work num] : The total number of processed workpiece.

[ Clear work info): Click [ Work Para] -> [ Clear work info), reset the time and work num zero.

6.3 Set Processing Format Parameters

Searchnum  Offset Dislocation
1 100.000 0.000

1 100.000 0.000

Back

Y+ [ Work para H Camera para

0.00

|
X+ [Model setﬁngs][ Match test ]
J

y- L Cut test M Normal cut

|| Enable valid zone
("] Cutting after search over
Speed(mm/s): 200.0 | [7] Back after processing

|| Step mode

[Num ] : Specify the search target number to match. You can specify the number of graphics on X-axis and Y-axis
direction.
[ Offset] : The distance of each move on axis direction. The offset in the X axis direction is the column spacing.
The offset of the Y direction is the line spacing.
[ Dislocation ] : There are lines dislocations or column dislocation in array-graphics, you can set the X-Dislocation
and the Y-Dislocation respectively.

© 2016 Ruida Technology. All Rights Reserved.



)

RDVision Laser Cutting Control Software Operation Manual A
[ Position] : Set current position-point as the machining-starting point.

[Back] The laser head moves back to the machining-starting point.

[ Path Browse] Browsing matching-search path and view the camera zones.

[ Simulate] Details please refer to section 6.5.1

[ Custom] User defines search path, it can be nested custom search path.

When set “Array first”, array path for systemic circulation, and the custom path for the minor cycle.

When set “Custom first”, custom path for systemic circulation, and the array path for the minor cycle.

Enable custom path ’Array first v

MO X

Custom First

[ Delete J[

add || uwp

Cem [

Madify ] [ Down

[ Export ] [

Import ] [ Close
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6.4 Devices Connect

Appears follow dialog box:

Link Machine h_

Note:Please Link Machine

| ©uss Auto
@ ETHERNE 192 . 168 . 1 . 100

[ OK } [ Cancel J

There are two device connect ways: USB and Web. Click [ Device port] button, then set the connection ways and

select connection port.

[USB] : If the computer is only connected to a laser device, you can set this option to automatically. The software
will automatically determine the connection interface to the device. When the computer is connected to more than
one laser equipment, you need to first click on the [Device Port] button. In the dialog box, click [Search] button.
The search is completed, the drop-down list will be displayed the connected currently device interface. User selects

the desired device interface, can output to the specified device.

[ Web] : If the computer is only connected to a laser device, you can directly input IP address in the default device
IP. When the computer is connected to more than one laser equipment, similar to the [USB] . Find the device has

been connected, and select corresponding IP address of the device from the drop-down list.

6.5 Control single-axis motion, back to zero

6.5.1 Manually control single-axis motion

Single-axis motion control, you can only control one axis motion, you can set distance, speed of movement.
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Searchnum  Offset Dislocation
< 100.000  0.000
v: 1 100.000  0.000
Y+ [ Work para H Camera para ]
0.00 [Model set’dngs][ Match test ]
y- [ Cut test ” Normal cut }

Feed

[] step mode
Speed(mm/s): 200.0

J—

0.0

[ Stepping distance): As shown:

v |

x4

["]Enable valid zone
[ cutting after search over
Back after processing

, fill out the step value in the edit box. Single-axis movements, in

accordance with the stepping distance move as a unit.

[Speed]: Set a single-axis movement speed, user-defined movement speed value.

6.6 Processing and Simulate processing

6.6.1 Simulate processing

Processing data is ready, the user can simulate processing to preview machining results.

Click [Simulate] button, starting the simulate processing.
Click [Start/Pause] button to pause, click [Stop]] button to stop.
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Search num ﬁoffset Dislocation

- 1 100.000  0.000

y: 1 100.000 0.000 | Simulate

Y+ [ Work para ][ Camera para ]
x- [9-99 | x+ [Model setmgs][ Match test |
= | cuttest || Normalaut |
U+ ||Feed

[] step mode

["]Enable valid zone

Speed(mm/s): 200.0

[] cutting after search over
Back after processing

6.6.2 Cut Test

Cut graphics at the current position.
Click [Cut test] button.
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Searchnum  Offset Dislocation

o 1 100.000  0.000
y: 1 100.000  0.000 -_sm e
Y+ [ Work para ][ Camera para ]
X- |29 x4 | | giodabsatiagiey Match test
y- Cut test Normal cut
U+ ||[Feed| U-
5 ["]Enable valid zone
[Cstep modeWi” [ cutting after search over
Speed(mm/s): 200.0 Back after processing

6.6.3 Processing

Confirmed the processing parameters are correct. Click [ Start/Pause ] button to process workpiece. Click
[ Start/Pause] button to pause, click [stop] button to stop.

Searchnum  Offset Dislocation

o 1 100.000  0.000 m——
y+ 1 100.000  0.000 -_sm e
T —
Y+ [ Work para ][ Camera para ]
x- [9-99 | x+ [Model settings ][ Match test ]
Y- Cut test Normal cut
U+ ||[Feed| U-
3 le vali
[Fl Step mode || Enable valid zone

| [ cutting after search over
Speed(mm/s): 200.0 Back after processing

[ Match test] Details information please refer to 5.2.2
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Thank you very much for using the product from Shenzhen RuiDa Technology!
All parts of this manual description, all rights reserved by Shenzhen RuiDa Technology Co., Ltd. Without our
permission, any company or individual shall not reprint, copy or distribute the content related to this product
manual. We keep the rights to revise or update the contents without notice.
If any comments and suggestions please feel free to contact us.
Phone: 0755-26066687 Fax: 0755-26982287
Website: www.rd-acs.com
Address: 1B-1, Building 5, Tian'an Nanyou Industry Area,
Dengliang Road, Nanshan District, Shenzhen, P.R.C.
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